Teaching reading comprehension on narrative text by using short story: A case on teaching method

David Suranta Sinamo*, Herman Herman*, Tiarma Intan Marpaung*

*Department of English Education, Universitas HKBP Nommoens, Pematangsiantar, Pematang Siantar, Indonesia

Abstract: The main goal of this research is to know the effect of short story as a media to the students’ ability in reading comprehension. Short story can help the students at Grade Eight in SMP Negeri 9 Pematangsiantar to improve their ability in Reading Comprehension because the students had low motivation in reading. This research applied quantitative method. The population of this research at grade eight of SMP Negeri 9 Pematangsiantar. The subject of this research is VIII-1 as experimental class consist of 30 students. and VIII-2 as the control class consist of 30 students. To analyze data, researcher used SPSS version 24, by conducting descriptive analysis, normality test, Wilcoxon test, Homogeneity test and Mann Whitney test. The results of data analysis using Mann Whitney test it is found that the Assympt value. Sig (2-tailed) on the Mann Whitney test is 0.000 < 0.05 Ha is accepted and H0 is rejected. According to the aforementiod data, it can be concluded that using short story as a media, has a more significant impact than the class that do not use short story to the students’ ability in reading comprehension on recount text at grade eight in SMP Negeri 9 Pematang Siantar. The result is the mean score of post-tests in experimental class is 88,50 and, in the control, class the score of post-test is 45,00. Based on the finding of this research, the researcher concludes that the alternative hypothesis (Ha) is accepted and null hypothesis (H0) is rejected.

Keywords: Effect; narrative text; reading comprehension; short story

Introduction

Language has an important role for all people in the world. They used it to communicate with others a social human. Besides that, it is also used to express people’s idea, and feelings with others. It is based on Hornby’s definition which is in Oxford Learner’s Pocket Dictionary (2008),” language is way of expressing ideas and feelings using movements, symbols, and sounds”. Moreover, by using language people can predict how the user’s personality, education, society, and culture is. Learning of a language is very important for us, especially English language. The first reason is that English is considered as an international language. It means that by using English language, we can communicate with many people from others countries in the world. Another reason is that most of books, articles, journals of sciences, newspapers, magazines, advertisements, TV programs, and job vacancies use English. We need to master English in comprehending all of them. If we can’t master it, we will lose much information.

Nisa (2018:25) stated that to learn English there are four skills taught to the students, they are: listening, speaking, reading and writing. Among the four language skills, reading is one of the skills that many parents pay attention to. However, just like other language skills, reading is not only able to understand a series of words contained in a book, but reading is a way to train the brain to try to digest and remember information.

Mastering reading in English is very important because many books are written in English such as academic book, magazine, and newspaper. Reading becomes essential because it can develop our knowledge. Through reading, we can get a lot of information, enjoyments, and even problem solutions. Tarigan (2015) stated reading is a process carried out and used by readers to obtain messages conveyed by the author through the medium of words for written language In the classroom learning process, reading has a purpose, namely through reading it is hoped that students can add broader knowledge and insight, add
new vocabulary, can improve students critical thinking skills and students can also increase their creativity through reading. Therefore, reading is very important especially for students. To achieve the objectives of reading, teacher should develop the student’s ability especially in reading skill to understand more complex texts and students are also expected to be able to more easily understand the contents of a reading text. In learning English in class, students are asked to pay attention to a given text and after that students are asked to read the text. In this process, students still have problems in learning English, especially reading texts. Students still found it difficult to pronounce words in English and they also found it difficult to understand an English reading text. Reading is a process of developed meaning from the text. They also mention that it is a process in which students actively search in making meaning in what they read from the text to get information or understand about the reading comprehension.

Reading comprehension is defined as the language learner’s ability to understand and comprehend a written text to found the main idea and specific information. Reading comprehension is a dialogue author and reader (Ivantara, Herman and Manalu, 2020). The activity needs ability to communicate with an author. Gascoigne (2008:674) states that reading comprehension can help readers gain a better understanding of text. The problem that many students has in reading comprehension is they do not know how to comprehend a text to get information or knowledge from the text. Westwood (2008) shows that there are some causes of reading comprehension difficulties, they are limited vocabulary knowledge, lack of fluency, lack of familiarity of the subject matter, inadequate use of reading strategies, readability, weak verbal reasoning, problems in processing information, and problems in recalling after reading.

Comprehending the English reading text is not an easy thing, so that is why there are many students find difficulties in comprehending the English text (Westwood, 2008). The researcher can use a media to help students to know student’s ability in reading comprehension. If the media carries messages or information that aims to convey teaching purposes, then the media is called learning media. In the learning process, learning media is one of the stimulants and tools provided by the teacher to encourage students to learn quickly, precisely, efficiently, and correctly, and there is no verbalism (Suhana, 2014:61). Before using the media as a learning medium, the teacher should first know the forms of media so that it is easier to choose the suitable media in the learning process.

Arsyad (2019:19) suggests that learning media in the teaching and learning process can generate new desires and interests, generate motivation and stimulation of learning activities, and even bring psychological effects on students. Learning media will make transferring knowledge to students more straightforward and more enjoyable. Learning process can be conducted effectively by using the right learning media for motivating students to study in the classroom. Right learning media can help learning process in the classroom. The way to make teaching reading effectively as a teacher we should have a good media to make the students interested to the material we will teach in the classroom.

Media is an important thing in the teaching and learning process. “Several varieties of media employed in the method of learning and teaching English like story, video, audio, picture story, film, and others. Generally, media for teaching will has a combination like animation. Moreover, the short story is anticipated to form the students fascinated by reading, is associated with reading and appreciating literature. Used the short story as learning media for motivated students in reading is a very effective way. A short story could be an easier approach as media because it is simple, has the standard of being universal and story can permit the teacher to deal with the human matter.

In general, short story are story that has shorter texts than other texts. Short story can make readers interested in reading the text. Although, short story has a shorter text, short story already has a complete story section, which consist of the beginning, middle and ending. Short story has their own characteristics compared to other texts, it supported by Setyani (2009) define that the short story is interested, can also help to stimulate the students’ curiosity toward the target culture and language. The function of the short story it owns is to entertain and to develop the reading comprehension related to students’ opinion.

In syllabus of grade eighth of junior high school that recommended by the government, there are three English texts that should to be mastered by the students. They are descriptive, narrative, and recount text. In this study, the researcher will only focus on the ability of the grade eight students of junior high school particularly in reading narrative text. Narrative text tells us about an interested story that can make students enjoy. As stated by Farris (2004:477), “reading narrative text is often referred to aesthetic reading because one reads it for enjoyment and pleasure the narrative is a text that tells a story and, in doing so, entertains the audience.

The narrative can be imaginary or factual (fairy tales, mysteries, fables, romances and adventure stories, myths and legends). Simare-mare et al (2022) describe many different types of narrative; namely humor, romance, crime, real-life fiction, historical fiction, mystery, fantasy, science fiction, diary novel, and adventure.

By the data of researcher’s experience in SMP Negeri 9 Pematangsiantar, when researcher did the experience internship teaching practice program (PPL), the researcher found some problem of the students. The students were very difficult to comprehend the text especially in narrative text.
Students did not enjoy in reading because the students did not read properly and the students were difficult to understand what they had read. This statement is supported by Desfiyenti & Gafar (2021), who states that the low proficiency of English words also causes the student's problem in comprehending the text with the students. In general students at SMP Negeri 9 have a problem in reading because students think that English lessons are not important and uninteresting, due to a lack of interest and motivation to learn, and students' vocabulary in English is low. Referring to curriculum 2013, the standard of minimum criteria (KKM) in SMP Negeri 9 Pematangsiantar is 65 in English subject for grade eight.

The researcher concluded that students in SMP Negeri 9 Pematangsiantar especially in grade eight, the students still has problems in reading comprehension. The students has low score in English lesson, because the students has problem in learning English lesson especially many students found difficulties in comprehended the English text. It means, the students should improve their ability in reading comprehension to get better scores than previous scores.

To solve the problem found above, the teacher should use the right media. The right media helps learning activities in the classroom. The way to make teaching reading effectively as a teacher we should has a media to improve ability students’ in reading comprehension. The used of learning media is expected to be able to more quickly accept student learning material and attract students' interest in learning (Musfiqon, 2012). Basically, the use of the media in the process of teaching and learning English will attract students’ motivation and attention (Sinaga and Oktaviani, 2020). Using of media is needed to conduct teaching and learning process in the class. By using media, the students will be enjoyable, interested and pleasure to learn English vocabulary, make the message clearly, can motivate the student to learn, can increase the quantity of teaching and learning. So, the researcher used short story to know students’ ability in reading comprehension.

There is a previous study related to the same media. The research comes from Jeni (2020) Entitled “The Using of Short Stories to Enhance Students’ Reading Comprehension”. Based on the result, it can be concluded that the implementation of short story can enhanced the students’ reading comprehension ability. Short story makes students interested in reading because the students like to read story with short version and easy to understand. It can make students easy and enjoying the story especially with narrative story. Because of it the students can comprehend the story. It means that there was significant difference between students’ reading achievements of narrative text taught by using short story and without using it. The difference between this research and previous research is that the researcher

<table>
<thead>
<tr>
<th>Table 1. Students’ scores in English subject</th>
</tr>
</thead>
<tbody>
<tr>
<td>No</td>
</tr>
<tr>
<td>-----</td>
</tr>
<tr>
<td>1.</td>
</tr>
<tr>
<td>2.</td>
</tr>
<tr>
<td>3.</td>
</tr>
<tr>
<td>4.</td>
</tr>
<tr>
<td>5.</td>
</tr>
<tr>
<td>6.</td>
</tr>
<tr>
<td>7.</td>
</tr>
<tr>
<td>8.</td>
</tr>
<tr>
<td>9.</td>
</tr>
<tr>
<td>10.</td>
</tr>
<tr>
<td>11.</td>
</tr>
<tr>
<td>12.</td>
</tr>
<tr>
<td>13.</td>
</tr>
<tr>
<td>14.</td>
</tr>
<tr>
<td>15.</td>
</tr>
<tr>
<td>16.</td>
</tr>
<tr>
<td>17.</td>
</tr>
<tr>
<td>18.</td>
</tr>
<tr>
<td>19.</td>
</tr>
<tr>
<td>20.</td>
</tr>
<tr>
<td>21.</td>
</tr>
<tr>
<td>22.</td>
</tr>
<tr>
<td>23.</td>
</tr>
<tr>
<td>24.</td>
</tr>
<tr>
<td>25.</td>
</tr>
<tr>
<td>26.</td>
</tr>
<tr>
<td>27.</td>
</tr>
<tr>
<td>28.</td>
</tr>
<tr>
<td>29.</td>
</tr>
<tr>
<td>30.</td>
</tr>
</tbody>
</table>

Average: 64.06
examines the eighth grade of SMP Negeri 9 Pematang Siantar. The difference lies in the subject, and the population. Dealing with the problem above, the researcher is expected to help the students in order to improve their reading comprehension by short story media

Method
Research Design
This research used quantitative research with used quasi experimental research design. According to Ary et al. (2010:22), "Quantitative research used objective measurement to gather numeric data that are used to answer question or test predetermined hypothesis". Quantitative research is qualified as experimental or non-experimental, where an experimental design based on Ary et al (2010:301), is the general plan for carrying out a study with an active independent variable. The design is very important because it determines the study of internal validity, which is the ability to reach valid conclusions about the effect of experimental treatment on the dependent variable. It means that experimental design is the research design that is use to find the influence of one variable to another.

<table>
<thead>
<tr>
<th>Group</th>
<th>Pre-Test</th>
<th>Treatment</th>
<th>Post-Test</th>
</tr>
</thead>
<tbody>
<tr>
<td>Experimental</td>
<td>X1</td>
<td>Y</td>
<td>X2</td>
</tr>
<tr>
<td>Control</td>
<td>X1</td>
<td>-</td>
<td>X2</td>
</tr>
</tbody>
</table>

Experimental Group: Short story media
Control Group: Conventional media
X1: Pre-test
X2: Post-test
Y: Treatment used short story media
-: Conventional media

Population and Sample
According to Best and Khan (2006:13), population is any group of individuals that has one or more characteristics in common that are of interest to the researcher. In this study, the population including all the students in grade VIII in SMP Negeri 9 Pematang Siantar.

The reason why the researchers choose the population from grade VIII because when the researchers did the teaching practice in this school, the researcher found that the students has difficulties to comprehend the text when they read the passage. The population of this research was all the students in the grade VIII students of SMP Negeri 9 Pematang Siantar in the academic year in 2023/2024, consist of 9 classes. The total population of students in grade VIII: 265 students.

<table>
<thead>
<tr>
<th>Class</th>
<th>Students</th>
</tr>
</thead>
<tbody>
<tr>
<td>VIII-1</td>
<td>30</td>
</tr>
<tr>
<td>VIII-2</td>
<td>30</td>
</tr>
<tr>
<td>VIII-3</td>
<td>30</td>
</tr>
<tr>
<td>VIII-4</td>
<td>30</td>
</tr>
<tr>
<td>VIII-5</td>
<td>30</td>
</tr>
<tr>
<td>VIII-6</td>
<td>30</td>
</tr>
<tr>
<td>VIII-7</td>
<td>28</td>
</tr>
<tr>
<td>VIII-8</td>
<td>28</td>
</tr>
<tr>
<td>VIII-9</td>
<td>29</td>
</tr>
<tr>
<td>Total</td>
<td>265</td>
</tr>
</tbody>
</table>
According to Best and Khan (2006:13) a sample is a small proportion of the population that selected for observation and analysis. The researcher chooses class VIII-1 and VIII-2 as the samples of this research. The samples are 60 students; there are 30 students VIII-1 as an experimental class by used short story media, and 30 students in class VIII-2 as a control class by used conventional media. This research used purposive sampling to take the sample. Purposive sampling can utilize by the researcher to choose research participants. Herman, Sibarani and Pardede (2020) explained purposive sampling is the process of selecting sample by taking subject that is not based on

<table>
<thead>
<tr>
<th>Group</th>
<th>Class</th>
<th>Students</th>
</tr>
</thead>
<tbody>
<tr>
<td>Experimental</td>
<td>VIII-1</td>
<td>30</td>
</tr>
<tr>
<td>Conventional</td>
<td>VIII-2</td>
<td>30</td>
</tr>
<tr>
<td>Total</td>
<td></td>
<td>60</td>
</tr>
</tbody>
</table>

**Table 4. Sample of the Research**

**Instrument of the research**

An instrument is very useful to collected data required in an experiment. The researcher used the test as the instrument in this research. In conducting the experiment, the researcher concerned about short story media to comprehend their understand in recount text to grade eight of junior high school. The researcher used multiple choice for the pre-test and the post test. The researcher used the student’s reading comprehension test by a test given with multiple choices consisted of 40 items, where it consisted of 20 for pre-test questions and 20 for post-test questions. The aim is to obtained information about the students' reading comprehension ability.

**The technique of data collection**

The data collected by test. Kind of the test is multiple choice questions. The test is compared the students’ ability in reading comprehension by give pre-test and post-test. Based on Djwandono (2008:12) a test is a tool or procedure used to measure the students’ language proficiency. It means that a test is one of the rules that will be useful to know how far the students have understood the material. The researcher will use the reading comprehension test in collecting data as the main instrument. The procedures for data collection are as follows:

**Pre-test**

The researcher used multiple choices technique that consisted 20 items. Multiple choices technique is a technique that designed by used 4 choices and the students choose one correct answer.

**Treatment**

The treatment conducted after pre-test. In the experimental group, the students taught by applied short story media while control group taught without

short story. Both of the group got the same reading material.

**Post-test**

After treatment, the researcher gives the post-test in the last meeting, the teacher shared the question that consisted of 20 question multiple choice. The function of the post-test is to know the mean scores of the experimental group and the control group after treatment finish.

**Technique of data analysis**

Analyzing data is a requirement for quantitative research. After all relevant data from the lists of pre-test and post-test values from both the experimental and control groups have been thoroughly acquired, data analysis is completed.

To analyze the data, some formulas were taken through mean of variable, standard deviation and the t-test formula.

**Scoring Students Test**

The results of the tests were examined by the researcher after she administered the pre- and post-tests. The students’ scores were determined by the computation after the verification and calculating processes were finished.

**Descriptive Analysis**

The volume of data, maximum value, minimum value, average value and other research data characteristics can be explained and described using statistical analysis. In SPSS version 24, the researcher was done the descriptive analysis by doing some steps, including:

1. Click Variable View
2. In the first column “name” type PreEx and “label” with Pre-Test Experimental.
3. In the second column “name” type PostEx and “label” with Post-Test Experimental.
4. In the third column “name” type PreCon and “label” with Pre-Test Control.
5. In the fourth column “name” type PostCon and “label” with Post-Test Control.
6. In the “decimals” section, select 0, while the rest options are default.
7. Click the Data View, copy the excel research data which contains student test scores before then paste it into SPSS.
8. Save the input data on the computer.
9. Click the Analysis menu, select the Descriptive Statistics menu, then select Explore, move the student learning outcome variables to the dependent list column and class variables to the factor list column by clicking the arrows. Click Plots and select factor levels together then click continue then OK.
10. In the “decimals” section, select 0 for the result bar and class, while the rest is the default.

Normality Test
The normality test was performed to examine whether or not the research data is normally distributed. Normal data are required before undertaking parametric statistical analysis (paired sample t-test and independent sample t-test). The two most common normality tests in parametric statistics are the Kolmogrov Smirnov test and the Shapiro-Wilk test. The significance value was a metric used in the normality test. Shapiro Wilk is a superior option for use in normality testing when the sample is fewer than 50, and it may be argued that the data is normal if it has a significance value of 0.05 for both tests. On the other hand, for large samples >50, use Kolmogorov-Smirnov for more accurate results. If the data is normal, the independent sample t-test and the paired sample t-test is next be performed, but if the data is not normal, then the Wilcoxon test and Mann Whitney test is carried out. In SPSS version 24, the researcher was done the normality test by doing some steps, including:
1. Click Variable View.
2. In the first column “name” type Outcomes and “label” with Student Learning Outcomes.
3. In the second column “name” type Class as well as in the “label”.
4. In the class variable at the values option, type 1 in the value column and pre-test experimental at the label, click add, then add the value column by typing
5. 2 and post-test experimental at the label. Click add again, then add 3 to the value and pre-test control to the value, then click add and type 4 to the value and post-test control to the label, then click OK.
6. In the “decimals” section, select 0 for the result bar and class, while the rest is the default.
7. Click Data View, copy the excel research data which contains the scoring students test then paste it into SPSS with each code 1, 2, 3 and 4 respectively.
8. Save the input data on the computer.

Paired Sample T-Test or Wilcoxon Test
Use the paired-samples t-test to determine whether the means of two paired samples differ. The paired sample t-test requires normally distributed data, which are the test conditions for the previous normality test. The paired sample t-test does not require homogeneous data variance. This test is used to determine whether the means of two paired or related samples differ from one another. Samples with the same person but receiving two different treatments are referred to as paired samples. Researchers can employ the Wilcoxon test nevertheless, if the normalcy test findings reveal aberrant data results. The steps for doing the paired sample t-test on the SPSS version 24 including:
1. Selecting Data View, click File, then Open, then Data, then select input data stored in the previous descriptive analysis step.
2. Selecting the Analyze menu, then Compare Means, then Paired-Samples T Test. In the dialog box that appears, move the data in the left column to the right column by clicking the arrow. And on the Options menu, the Confidence Interval Percentage option remains at the default option of 95%, then select continue and click OK.

Basis for making a decision on the paired sample t-test, if the 2-tailed sign value is less than 0.05 then there is the effect of the treatments, but if the Sig (2-tailed) > 0.05, then there is no effect of the treatments. The same decision is made on Wilcoxon test. If the data abnormal, the researcher can use Wilcoxon test. The Wilcoxon test determines whether the means of two matched samples differ. Ordinal and interval scale data should ideally be used in the Wilcoxon test. Since the Wilcoxon test is a component of non-parametric statistics, normally distributed research data are not necessary. The steps for doing the Wilcoxon test on the SPSS version 24 including:
1. Click Variable View
2. In the first column “name” type PreEx and “label” with Pre-Test Experimental.
3. In the second column “name” type PostEx and “label” with Post-Test Experimental.
4. In the third column "name" type PreCon and "label" with Pre-Test Control.
5. In the fourth column "name" type PostCon and "label" with Post-Test Control.
6. In the "decimals" section select 0, while the rest options are default.
7. Click the Data View, copy the excel research data which contains student test scores before then paste it into SPSS
8. Click the Analyze mem, select Nonparametric Tests, then Legacy Dialogs and select 2 Related Samples Move the data to the left in the Test Pair dialog column, select the Wilcoxon test type and click OK.

Homogeneity Test
The homogeneity test evaluates whether the distribution of data across two or more groups is homogeneous (equal) or heterogeneous (unequal). Homogeneous data is one of the conditions, but not a mandatory one, for the independent sample t-test. The homogeneity test was used in this research to determine whether or not the variances of the experimental class post-test data and the control class post-test data were homogeneous. The homogeneous test steps in SPSS version 24 are as follows:
1. Select the Variable View menu.
2. In the first column "name" type Outcomes and Student Learning Outcomes in the "label".
3. In the second column "name" type Class as well as the "label".
4. In the "decimals" section, select 0 for the result bar and class, while the rest in the default.
5. Click the values column in the Class, type 1 in the value column with the label post-test experimental, click add the values column by typing 2 and label post-test control, click add then click OK.
6. Select Data View, copy the experimental class post-test data and paste it into SPSS with code number 1 followed by control class post-test data with code number 2.
7. Click the Analyze menu, select Descriptive Statistics, then select Explore.
8. Move the student learning outcomes variable to the dependent list column and class variables to the factor list column by clicking the arrows. Click Plots and mark the power estimation then click continue then OK.

Independent Sample T-Test or Mann Whitney Test
To find out if the means of two unpaired samples differ, perform the independent sample t-test. The data must be homogenous (not absolute) and regularly distributed in order to pass the independent-samples t-test. You can apply the alternative Mann Whitney test if the data is not typical. In this research, an independent test sample t-test was used to examine the post-test results for both the experimental class and the control class in order to address the hypotheses. The independent sample t-test steps for SPSS version 24 include:
1. Selecting Data View, select the File menu, then Open, and Data. Enter the homogeneity data that was previously stored on the computer and click Open.
2. Selecting the Analyze menu, then Compare Means, then select Independent- Samples T-Test. In the dialog box, move the student learning outcomes variable to the test variables column on the right by clicking on the arrow. as well as the class variable to the grouping variable column. Click Define Groups, type 1 on Group 1 and 2 on Group 2, then select Continue and click OK.

The Mann Whitney test might be used by the researcher if the data are not typical. The Mann Whitney test looks for differences between the means of two unpaired samples. The Mann Whitney test is a non-parametric statistic that does not require a constant number of samples. It is not necessary to have homogeneous and regularly distributed research data for the Mann Whitney test. In cases where the research data is not homogeneous and not normally distributed, the Mann Whitney test is employed as an alternative to the independent sample t-test. The Mann Whitney test steps for SPSS version 24 include:
1. Click Variable View.
2. In the first column "name" type Outcomes and "label" with Students Learning Outcomes.
3. In the second column "name" type Class, "label" with Class.
4. Click the values column in the class, type 1 in the value column with the label post-test experimental, click add the values column by typing 2 and label post-test control, click add then click OK.
5. In the "decimals" section select 0, while the rest options are default.
6. Click the Data View, copy the excel research data which contains student post-test scores before then paste it into SPSS. Put the post test of the experimental class at the outcomes with the code 1 at the Class, then followed by the post-test of the control class below the experimental post-test and the code 2 at the Class.
7. Click the Analyze menu, select Nonparametric Tests, then Legacy Dialogs and select 2 Independent Samples. Move the data to the left, the first Students Learning Outcomes to the Test Variable List and Class to the Grouping Variables.
Click Define Groups, input the Group 1 with 1 (for experimental) and Group 2 with 2 (for control) and click Continue. Make sure in the Test Type Mann-Whitney U is checked, then then click OK.

**Result**

After carrying out the data analysis process, several findings were obtained that could answer the research problem:

By the data, the researcher found the score of pretest and posttest in the experimental class. The lowest score of pre-test in experimental was 15, and then the highest score was 55. The lowest score of post-test in experimental was 75 and then the highest score was 95. The researcher found, the average of pretest was 44.00 and the average of posttest was 88.50.

![Figure 1. Score in Experimental Class](image1)

![Figure 2. Total Score in Experimental Class](image2)
By the data shown in figure 2, it was clear that the researchers found the total score of pre-test in experimental class was 1,320 and the total score of post-test was 2,655.

![Figure 3. Score in Control Class](image)

By the data, the researcher found the score of pretest and posttest in the control class. The lowest score of pre-test in control was 20, and the highest score was 55. The lowest score of post-test in control was 25 and then highest score was 60. The researcher found, the average of pretest was 37,00 and the average of posttest was 45,00.

![Figure 4. Total Score in Control Class](image)

By the data, the researcher found the total score of pretest in experimental class was 1,110 and the total score of posttest was 1,350.

The researcher found out that there are several effects that occurred in the samples that use to the students’ ability in reading comprehension on narrative text taught by using short story. In the experimental class, the average score of the pre-test is 44,00 and the
post-test with treatment using short story as a media is 88.50 and no students experienced a decrease in grades (negative rank) or statistic score (ties). Both experimental classes increased in value with a mean of rank 15.50, with a sum of rank 465.00 and Asymp. Sig (2 tailed) in the Wilcoxon test is 0.000, but it is clear that the post-test mean score in the experimental class is higher than that in the control class. The mean rank on learning outcomes (post-test) in the experimental class is 36.30 with a sum of rank of 1089.00.

Discussion
The end result of this research based on the research problem, the researcher find the solution to the research problem, particularly to find out if short story as a media significantly affected the students’ ability in Reading comprehension on narrative text and see the effect the use of and without use short story as a media to the students’ ability in reading comprehension on narrative text at SMP Negeri 9 Pematang Siantar. When conducting research, researcher found other problems that affect students’ reading comprehension using short story. The researcher found the problem in interpretative level. This level requires the reader to go beyond the information provided by the author. Readers are required to see the significance of the data, note some relationships, such as: cause and effect, the relationship of parts to the whole, make comparisons, make conclusions and inferences. In simple terms, when the research was conducted, several phenomena emerged, including the students’ problem in the lack of to understanding the meaning of the text. Which made it difficult for them to understand the reading. During the treatment, the researcher guided the students to overcome the problem by helping them memorize some ability in reading comprehension to understanding the text, and another problem was that they were not familiar with the text and had no background knowledge about the text. In this case, when the treatment was given, the researcher tried to select some passages that had a strong correlation with the students’ background knowledge.

In this study, the hypothesis testing allowed for the conclusion to be taken that students who are taught narrative text using short story. This result was made possible by employing quantitative methods, a quasi-experimental research design, and data analysis. The average score on tests measuring short story in an experimental class. With a sum of rankings of 1089.00, with the mean rank 36.30. The results of the final Mann Whitney statistical test serve as a standard for determining whether there is a substantial correlation between the short story and students’ capacity to read narrative texts. For the criteria, Ha is accepted if the output of Asymp. Sig (2-tailed) in Mann Whitney test > 0.05. From the test statistics in Mann Whitney test, the result of the assymp.Sig (2-tailed) is 0.000 < 0.05, then Ha is accepted and H0 is rejected.

The result of this research is same with the previous researches that conducted by Ikram (2022), Hasibuan (2019), Ibrahim (2022), where in their researches, they concluded that the short story media is significantly affects the students’ ability in reading comprehension on narrative text. This proves that short story significantly affects the students’ ability at SMP Negeri 9 Pematang Siantar in reading comprehension on narrative text.

This research compared this research with the previous research using Hasibuan’ thesis. The result of her thesis is in the description of the data was taken from 33 students of experimental class and 32 students of control class. The experimental class which had the mean of pre-test was 44.00 before the implementation of short story that were given as treatments. After the students were given treatments in experimental class by using short story, the mean of post-test was 88.50. Meanwhile, the score of control class as follows, the mean of pre-test was 37.00. In control class, there was no implementation of short story in teaching narrative text. The mean of post-test was 34.06 while the mean of gained score was 13.4. Short story could be alternative material to help the students in understanding the narrative text.

The short story significantly effects on the students reading comprehension, because t-observed was (5.6) is higher than the t-table df (63) at the level of (0.05) was (1.99). It shows that t-observed> t-table (5.6 > 1.99). This finding shows that hypothesis of the study is true. Therefore, can be concluded that the application of short story significantly effects of reading comprehension.

The differences between Hasibuan’s research with this research is the result of the data was taken from 30 students of experimental class and 30 students of control class, in Hasibuan’s research, the data was taken from 33 students of experimental class and 32 students of control class. In this research, the experimental class which had the mean of pre-test was 44.8 before the implementation of short story that were given as treatments. After the students were given treatments in experimental class by using short story, the mean of post-test was 88.50. Meanwhile, the score of control class as follows, the mean of pre-test was 37.00. In control class, there was no implementation of short story in teaching narrative text. The mean of post-test was 34.06. Short story could be alternative material to help the students in understanding the narrative text.

The similarity of this research with previous research is the researcher same using short story to the student’s ability in reading comprehension, and the researcher used pre-test and post-test to know
student’s ability. By the data, short story can make students to understand about the meaning of the text in narrative text using. Students can easily understand about the meaning of story. Students have motivation to read the text especially the students can be brave to read narrative text using short story as a media.

**Conclusion**

The finding of this research indicates that the use of short story as a media is effective in improving students’ ability in reading comprehension on narrative text. The researcher found problem; the students have problem to understand the meaning of the text until the student got the lowest score. This research using quantitative method (quasi-experimental) design. The researcher using quasi experimental to know the effect of experimental class and control class. The researcher using all the students in grade eight as a population and VIII-1 and VIII-2 as the sample. By the data, score in experimental class is higher than the score of the control class and at the Mann Whitney test, the Assym. Sig. (2-tailed) is 0.000 <0.05, then Ha is accepted and Ho is rejected. Based on the research result and supported by some previous researches, it can be concluded that the use of short story is very effective in improving students’ ability in reading comprehension on narrative text at grade eight in SMP Negeri 9 Pematang Siantar.

**Acknowledgments**

The researchers would like to send their highest gratitude to those who have helped them in completing this research.

**Disclosure statement**

“The authors declare no conflict of interest.”

**References**


